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Kingdom® 2023

Installation and Licensing

Overview
This manual contains the information you need to install and configure the Kingdom software. 
Kingdom and all other related applications can be downloaded from the Kingdom Download 
site, and from Sentinel EMS (Entitlement Management System) at https://
softwarelicensing.ihsmarkit.com/ems/customerLogin.html.

Note: To log on to the EMS, you will need your company’s Entitlement ID (EID) which was 
included in the Entitlement Certificate sent to the company primary contact.

Planning your Installation or 
Upgrade

This chapter provides helpful guidance about the different 
Kingdom software and database installations and 
configurations available to you.

Downloading and installing 
Kingdom

Log on to the Sentinel EMS using your Entitlement ID (EID) 
included in your Entitlement Certificate email and download 
the software installation packages. You can also downlaod 
from the Kingdom Download site. To install, follow the 
installation wizards.

Performing Silent Installations Silent installations use the Microsoft Installer (MSI) installation 
file. This is useful for companies with controlled IT 
environments that centrally manage and deploy software to 
user computers.

Kingdom Licensing Kingdom has 2 types of licenses:
• Network for collaborative multi-user environments
• Standalone for single users

Installing Kingdom from a USB 
Drive

If you do not have internet connectivity and have received the 
physical media, you can install from the Installation Manager 
on the Kingdom Software USB drive.

Installing Third Party Software The three third-party applications are optional installations: 
Adobe Reader, SQL Server Express, and SQL Management 
Studio. 

Demo Projects Kingdom includes three demo projects: BEG, Sooner, and 
Golden. The projects require approximately 700 MB of space 
and use SQL Server Express for the project database

https://softwarelicensing.ihsmarkit.com/ems/customerLogin.html
https://softwarelicensing.ihsmarkit.com/ems/customerLogin.html
https://kingdomdownloads.enr.ihsenergy.com/
https://kingdomdownloads.enr.ihsenergy.com/
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Note: If you need help, contact Commodity Insights Client Services at 
ci.support@spglobal.com or at one of the numbers below: 

When connected, select Option 3 (Commodity Insights) and then Option 1 for Kingdom.

Also check out The Learning Center where you will find an ever-expanding selection of 
product training, fundamentals training, and virtual event opportunities.

SQL Server Express Service 
Configuration

If you install the Kingdom version of SQL Server Express, you 
need to define how to configure the service according to your 
working environment.

Installing the Administrator 
Console

The Administrator Console is intended for use by system 
administrators responsible for defining access permissions to 
Kingdom projects on an enterprise-wide scale. Used in 
conjunction with the Enterprise Project Selector, the 
Administrator Console provides system administrators with a 
single means of defining and communicating access to 
Kingdom projects for all Kingdom users.

Updating the Kingdom Software Service Packs and Hot Fixes are available for download from 
the Entitlement Management System or the Kingdom 
Download site.

Americas +1 800 597 1344

Asia Pacific +60 4 296 1125

Europe, Middle East, Africa +44 (0) 203 367 0681

https://learning.ihsmarkit.com/
https://kingdomdownloads.enr.ihsenergy.com/
https://kingdomdownloads.enr.ihsenergy.com/
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Planning your Installation or Upgrade
If you are performing a new installation of Kingdom, prepare for the installation by reviewing 
the hardware and system requirements in the latest release notes. If you are upgrading a 
previous version of Kingdom to Kingdom 2023, be sure to read Upgrading projects to 
Kingdom 2023 to understand the requirements and consequences of the upgrade before you 
continue. 

Kingdom 2023 is only backward-compatible with Kingdom versions 2015 HF4 and later. it is 
not compatible with earlier versions of Kingdom, which will affect your ability to work in and 
share projects still in earlier versions.

Installation checklist
The following checklist provides a summary of the steps and decisions required to 
successfully install Kingdom and any related software, such as the project database, license 
server, and Administrator Console, and upgrade existing Kingdom projects to the latest 
version:.

1. Define Hardware and system requirements. For the most recent requirements, see 
the latest version release notes available from the Kingdom Start Page, or online 
here.

2. Review Network and environment best practices.

3. Choose a database

4. Download the latest software

5. Install the downloaded software or install software from USB drive

You can also perform a silent installation

6. Obtain software licenses:

- For network licenses, install the network licensing tools.

- For standalone licenses, download your feature keys from the Sentinel EMS 
(Entitlement Management System) and then activate the your license from 
Kingdom. Just start Kingdom and follow the wizard.

7. Install and configure the database:

• SQL Server Express | SQ L Server | Oracle

8. Install Administrator Console (optional)

http://onlinehelp.ihs.com/Energy/Kingdom/TKS_Latest/Documents/Kingdom_Latest_ReleaseNotes.pdf
https://softwarelicensing.ihsmarkit.com/ems/customerLogin.html
http://onlinehelp.ihs.com/Energy/Kingdom/TKS_Latest/Documents/Kingdom_Latest_ReleaseNotes.pdf
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9. Upgrade existing projects to the latest version of Kingdom
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Network and environment best practices 

Network and environment best practices
This section provides some general recommendations for how to configure Kingdom on your 
network for a multi-user installation and how to maintain your environment for optimal 
performance.

Recommended Multi-User Configuration
The diagram below shows the recommended configuration for Kingdom in a multi-user 
environment.

Maintaining the Network Environment
The following practices will help improve the performance and reliability of Kingdom:

• Exclude the Kingdom installation folder and Kingdom file types from routine virus 
scanning. This will help improve software performance and may eliminate problems 
starting Kingdom.

• Monitor available disk space on any Kingdom network file servers to be sure they don’t 
exceed 85% capacity.

• Remove old and superfluous Kingdom project and data files. Use the Kingdom Data 
Management Tool to help with cleaning up old files.
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Network and environment best practices

Checking the Database Error Log
If database or other errors are occurring in your project, a useful resource for troubleshooting 
and resolving these issues is the database error log. The log is located inside the project 
folder:

\Kingdom Project Folder\ErrorLogs\Authorname_Log.txt

Kingdom Project Folder is the name of the project in question and Authorname is the 
name of the active author in the Kingdom project when the error occurred. Kingdom creates 
this folder and the log file only in the event that it receives error messages from the database 
software. This includes SQL Server, and Oracle. 
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Required database permissions 

Required database permissions
The permissions required to upgrade differ depending on the Kingdom database you are 
using. For projects in SQL Server and Oracle databases, you must enter your database log in 
credentials before upgrading a project.

Related topics
Installation checklist
Choosing a database

Database Required Permissions

SQL Server Express 
(Kingdom-specific version)

No special permissions required

SQL Server Db_Owner

Or

Db_Ddladmin + Db_Datareader + Db_Datawriter
For more information, refer to the available Microsoft 
documentation.

Oracle Default roles:
• Connect + DBA

Customized roles:
• Read/write data for all project tables
• Make DDL statements for schema
• Execute PL/SQL statements
For more information, refer to the available Oracle 
documentation.
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Choosing a database

Choosing a database
All Kingdom software features and modules support MS SQL Server Express, MS SQL 
Server, and Oracle databases. For more information about Kingdom database, see the 
Database Administration Guide.

SQL Server Express
SQL Server Express has a database size limit of 10 GB. Note that there is a 1 GB limit for the 
memory cache, which limits database efficiency with more than three or four users, especially 
when accessing projects with large amounts of well data. For more information, see 
Understanding SQL Server Express.

SQL Server
The SQL Server client and server need to be purchased and installed separately and works 
only on Windows operating systems. Theoretically, there are no limitations to the size of the 
database. SQL Server has multiprocessor support capability.

Oracle
The Oracle client and server Need to be purchased and installed separately and can operate 
on Windows or Unix / Linux operating systems. Theoretically, there are no limitations to the 
size of the database. Oracle has multiprocessor support capability. Kingdom is NOT certified 
on Oracle Express.
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Choosing a database 

Database Comparison

Related topics
Installation checklist
Required database permissions

Database Concurrent 
Users

RAM 
Buffer 

(cached 
records)

No. of 
CPUs

Database 
Size

Database 
Location

SQL Server 
Express (Auto)

~ 4 1 GB 1 10 GB ProjectDatabase folder 
inside project folder

SQL Server 
Express (Manual)

~ 4 1 GB 1 10 GB Program 
Files\SPGlobal\Kingdom
Suite folder of SQL 
Server Express computer

SQL Server 
(Single Project)

~ 80 Limited by 
system 
RAM

Limite
d by 
syste
m

Limited by 
system

SQL Server computer

SQL Server 
(Multiple Project)

~ 80 Limited by 
system 
RAM

Limite
d by 
syste
m

Limited by 
system

SQL Server computer

ORACLE ~ 300 Limited by 
system 
RAM

Limite
d by 
syste
m

Limited by 
system

ORACLE server
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Understanding SQL Server Express

Understanding SQL Server Express
SQL Server Express (SSE) is provided free of charge and is available as an optional 
download from the Entitlement Management System.

Before you select which version of SQL Server Express to download:

What is the Kingdom version of SQL Server Express?
This Kingdom version of SQL Server Express has a dedicated SMTKINGDOM instance with 
a pre-configured user name and password to simplify installation and integration with 
Kingdom.

Who should use SQL Server Express?
SQL Server Express is a good database choice for small offices and individual users with no 
database administration experience and no database administrator on staff. It is easy to 
administer and automatically creates the Kingdom project database. The Kingdom version of 
SQL Server Express is simple to implement because it creates a default SMTKINGDOM 
instance with an SMTKINGDOM login (with sysadmin (sa) permissions) and the password 
$ei$micMicro. However, this standard configuration may not meet your internal security 
policies.

SQL Server Express can only run on Microsoft operating systems. For Linux/Unix servers, 
you need to install Oracle.

Know Understand

SQL Server databases 
are not backward 
compatible

When you upgrade to a later version of SQL Server Express, the 
existing database is automatically upgraded. 
This upgraded database is not backward compatible to earlier 
versions. Your newer-versioned database will be unusable by a partner 
who uses an older, different version of SQL Server Express.

The version of SQL 
Server Express others 
are using

We suggest that you check with your organization and partners to 
compare versions before choosing which version to download. 
 If you do not know which version is being used by your collaborators, 
you may want to select the earliest version of SQL Server Express so 
that it will open legacy databases without upgrading them. For older 
versions of SQL Server Express, select an earlier version of Kingdom 
and then view available SQL Server Express versions listed as 
available downloads.

Your operating system Windows 10 requires SQL Server Express 2012 SP2 or later. Microsoft 
does not support earlier versions on this operating system.
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Understanding SQL Server Express 

There are two database options available when you create a new Kingdom SQL Server 
Express project database:

This section contains the following topics:

• Installation requirements

• Connection requirements for Auto SSE

• How is Auto SSE different from Manual SSE?

• Managing Manual and Auto SSE Projects

• Auto SSE and backward compatibility

Auto SSE Configured to be easily portable by automatically attaching and detaching 
the project database when you open and close Kingdom. As long as all 
data is contained in the project folder, when all authors are out of the 
project, you can copy or move the project without any tools or special 
operations.
Auto SSE is the simplest, cleanest option.

Manual SSE Management of Manual SSE projects, including attaching/detaching and 
moving the database, is done through the SSE Management Tool 
available from the Database Adminstration tool (DBAdmin).
With this option you must use the SSE Management Tool to copy or 
move projects.
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Understanding SQL Server Express

Installation requirements
The Kingdom version of SQL Server Express creates an SMTKINGDOM instance with a pre-
configured user name and password that Kingdom uses to connect to the SQL Server 
Express database. Installation of this instance should not affect existing instances of SQL 
Server Express installed by other programs.

If multiple users are going to access your Kingdom projects, you should install SQL Server 
Express on a shared network computer. You must be logged onto the computer where you 
want to install SQL Server Express.

For optimal Kingdom performance, run SQL Server Express on a dedicated computer with at 
least 8 GB of physical memory.

SQL Server Express is available for download from the Entitlement Management System and 
the Kingdom Download site.

Note: You only need to install SQL Server Express once. Reinstalling or updating 
Kingdom will not affect SQL Server Express.

Related topics
Understanding SQL Server Express

Connection requirements for Auto SSE

Version compatibility
When you upgrade SQL Server Express to a newer version, the existing Kingdom database 
is automatically upgraded. This upgraded database is not backward compatible to earlier 
versions. Your newer-versioned database will be unusable by a partner who uses an older, 
different version of SQL Server Express. In other words, if you are on the older version of 
SQL Server Express, you will not be able to open the Kingdom project.

If you try to open a Kingdom project that has been opened in a newer version of SQL Server 
Express and therefore upgraded, you will get an error message:

To open this project, you must upgrade your version of SQL Server Express or 
select a different, newer instance. Expand the Details section of this 
dialog box to see the current (newer) version and your installed version.

When you expand the Details section in the message box, the text gives the internal 
database versions. For a current list, search online for Microsoft SQL Server Internal 
Database Versions and Compatibility Levels

To open the project, you will need to upgrade the version of SQL Server Express on your 
computer to the version the project is in.

https://kingdomdownloads.enr.ihsenergy.com/
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Understanding SQL Server Express 

Your working environment: local or network
When using the Auto SSE option, successful connectivity depends on the configuration of 
your working environment. The following combinations are supported:

Note: When using Auto SSE, projects on the network cannot connect to a local SSE 
instance. Similarly, local projects cannot connect to an SSE instance on the network.

Local Project—Local database Instance
Your project and your SQL Server Express (SMTKINGDOM) instance are both on your local 
computer or another computer in your work group.

This is the simplest configuration. When you close a project, it is portable.

Network Project—Network database instance
Your project and your SQL Server Express (SMTKINGDOM) instance are both on your 
network - not on your computer. This configuration supports multiple projects on multiple 
computers connecting to a central SQL Server Express instance. Your network administrator 
needs to create a service account for SQL Server Express to use to access your Kingdom 
projects. For more information about installing SQL Server Express and creating the service 
account, see About SQL Server Express.

Working Environment Recommended Database Configuration

• Kingdom projects are on your computer or 
on a colleague’s computer

• You are a single user or have a small work 
group

Install SQL Server Express on the same 
computer as the Kingdom project.
Use a Local Project—Local database Instance 
configuration.

• Kingdom projects are on a shared 
resource on the network

• The Kingdom project and SQL Server 
Express instance are on different 
computers

Install SQL Server Express on a network 
computer, not on your own computer.
Use a Network Project—Network database 
instance configuration
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Understanding SQL Server Express

How is Auto SSE different from Manual SSE?
You have two options available to you when creating a new project database with SQL Server 
Express: Auto SSE and Manual SSE. Auto SSE is designed for easy project portability and 
Manual SSE maintains backwards compatibility with earlier versions of Kingdom. Auto SSE 
differs from Manual SSE in the following ways:

Note: Only data stored inside the project folder is included in any move or copy. Data stored 
outside of the project folder such as seismic files, author files, or tiff images of your 
raster logs, you need to copy separately.

For more information, see also Understanding SQL Server Express

Auto SSE Manual SSE

• Places the project database in the Kingdom 
project directory.

• Places the project database in the 
IHS\KingdomSuite directory under Program 
Files on the computer where the SQL Server 
Express instance is installed.

• Requires a computer that is designated as the 
database server.

• Automatically attaches the database  when 
the first user opens the project.

• Automatically detaches the database when 
the last user exits the project.

• Does not automatically detach or attach the 
project database.

• Requires the SSE Management tool to detach 
or attach the project database.

• Automatically attaches to any available 
SQL Server Express server if the original 
server is unavailable.

• Kingdom database is unavailable if the SQL 
Server database computer is unavailable.

• After all users exit the project, you can copy 
or move the project directory, including the 
database, with Windows Explorer.

• After all users exit the project, you must use the 
SSE Management tool to copy or move the 
project directory and database.

• Cannot connect to Kingdom versions 8.5 or 
earlier.

• Is backward compatible with Kingdom versions 
8.2 or later. You can attach the database using 
the SSE Management tool.

• Supports the following location 
combinations:

- Local Project—Local database 
Instance

- Network Project—Local Instance

- Network Project—Network database 
instance

• Supports mixed mode location combinations for 
your project folder and SSE instance. Your 
project on the network can connect to a local 
instance and vice versa.
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Managing Manual and Auto SSE Projects
Kingdom Auto SSE projects are the easiest to manage. The database files are stored in the 
project folder and you can perform file management tasks such as copy, move, backup, and 
delete using Windows Explorer.

The project database for Manual SSE projects is not located in the project folder. To perform 
file management tasks for Manual SSE projects you need to manage both the project 
database and the project files.

You can manage your Manual SSE projects with two tools:

• Manual SQL Server Express Project Management—available from the Kingdom Start 
Page, this utility provides a number of file management options for your Manual SSE 
projects, such as:

• making a project portable

• copying, moving, or deleting a project

• backing up and restoring a project.

• Kingdom Data Management—a data management application with a wide range of 
project inventory and management tools. Kingdom Data Management requires a 
separate license.

The Manual SQL Server Express Project Management tool manages only the SQL Server 
Express database and the files in the Kingdom project folder. By default, Kingdom files are 
saved in the project folder, but if files such as seismic data, author folders, or raster logs have 
been saved in locations outside of the project folder, these files are not included. Before using 
the Manual SQL Server Express Project Management tool to manage your project data, 
move all external files into the Kingdom project folder.

Caution: Applying any of the Manual SQL Server Express Project Management tool options 
to an Auto SSE project changes the project to Manual SSE. The project will no 
longer be automatically portable, but will be compatible with Kingdom versions 8.2 
and later. 

Auto SSE and backward compatibility
If you want to open an Auto SSE project in Kingdom 8.5 SP1 or earlier, you need to change 
the project to a Manual SSE project using the Manual SQL Server Express Project 
Management tool. Applying any of the Manual SQL Server Express Project Management tool 
options to an Auto SSE project changes the project to Manual SSE. The project will no longer 
be automatically portable, but will be compatible with Kingdom versions 8.2 and later. For 
specific instructions, see Auto SSE and Backward Compatibility in the Database 
Administration User Manual.

Related topics
Understanding SQL Server Express | Kingdom Project Database Conversions
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Upgrading projects to Kingdom 2023

Important: Always back up each project before opening it in a new release.

Kingdom 2023 is only backwards compatible with Kingdom versions including and after 
Kingdom 2015 Hot Fix 4. Once you upgrade to Kingdom 2023, any existing projects you try to 
open with Kingdom 2023 must be upgraded, and once upgraded, projects are no longer 
usable by any Kingdom version earlier than Kingdom 2015 Hot Fix 4.

You can upgrade individual Kingdom projects or you can upgrade multiple projects at the 
same time. We recommend that you create a full backup of any Kingdom project you plan to 
upgrade. The project backup needs to include a database backup as well as any other 
project files (for example, seismic files, grids, horizons, and faults).

Previous version support
Kingdom 2023 cannot automatically upgrade projects from version 2015 or earlier. You must 
first upgrade any 2015 or earlier versions of Kingdom projects to a minimum of version 2016 
before you can upgrade them to Kingdom 2023.

Upgrading from SQL Server Express 2014 to 2016
With the 2016 instance of the Kingdom version of SQL Server Express, you 
cannot upgrade an existing 2014 instance (or 2012 instance) to 2016. You must 
uninstall SQL Server Express 2014 first.

In addition, SQL Server Management Studio 2014 does not work with SQL Server Express 
2016 databases. We therefore recommend that you also uninstall SQL Server Management 
Studio 2014 before upgrading to 2016 (unless you are using SQL Server Express 2014 with a 
different product, in which case you can keep SSMS 2014 installed). For complete 
instructions see SQL Server Express 2014 SMTKINGDOM Instance Uninstall

Multi-Project databases
If you are upgrading from a version of Kingdom prior to Kingdom 2016, there are some 
special considerations for Kingdom projects in a multi-project database (one database with 
multiple Kingdom projects) rather than a single project database (a separate database for 
each Kingdom project):

Single Project To upgrade a single project to Kingdom 2023, simply open the project with 
Kingdom 2023. Kingdom prompts you to upgrade, and performs the upgrade 
for you automatically..

Multiple Projects To upgrade multiple Kingdom projects to Kingdom 2023 at the same time, 
use the Kingdom Project Upgrade Tool. For more information, see 
Upgrading multiple projects.

http://onlinehelp.ihs.com/Energy/Kingdom/TKS_2020/Documents/SQL Server Express 2014 Uninstall.pdf
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• Once you upgrade at least one project in a multi-project database, you can no longer 
create new projects in that database with prior versions of Kingdom. 

• You cannot create any new projects in a multi-project database until at least one project in 
that database has been upgraded to the current version. However, you can open earlier 
versions of projects with earlier versions of Kingdom. 

For more information about single and multiple project databases, see Choosing a Database 
in the Database Administrator Guide.

If you are using Kingdom Data Management (KDM) to copy a project, you cannot copy the 
project into a multi-project database unless at least one project in that database has been 
upgraded to the current version.

Upgrading a project that is using role-based security
The only SQL users who can upgrade a project that is using role-based security are the 
following:

Related topics
Troubleshooting failed upgrades
Custom Coordinate Reference System (CRS)

sysadmin The user who has the sysadmin server role 

The security administrator The SQL user who turned the role-based security module on
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Upgrading multiple projects
Kingdom provides the Project Upgrade Tool so you can upgrade multiple Kingdom projects to 
the latest version at the same time. This tool can expedite the upgrade process in 
environments with large numbers of Kingdom projects. See Using the project upgrade tool for 
step by step instructions.

If you are upgrading Kingdom projects with Access or SQL Server Express 2005 databases, 
you cannot use the upgrade tool. For more information see Upgrading Access or SQL Server 
Express 2005 Projects

The illustration below shows the main components of the Project Upgrade Tool window:

List of directories
The list of directories shows any directories containing Kingdom projects that you have added 
to the Project Upgrade Tool. Any projects in these directories display in the list of projects 
below the directory list. You can filter the list of projects by selecting or clearing the check 
boxes next to the directories you want to include or exclude. Click  to add directories to the 

list or  to remove them from the list.
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Status Types and Filters
Project databases have four possible statuses:

You can filter the list of projects by selecting or clearing the check boxes next to the different 
database statuses. Clearing a check box hides any databases with that status from the list.

List of projects
The list of projects shows the Kingdom project databases available in the directories selected 
in the list of directories. You can filter the project databases shown in this list by selecting or 
clearing the check boxes for individual directories or for the different database statuses.

The project database list shows the following information:

Project databases that require you to provide logon credentials have a key icon  next to 

the project name. Click  and then enter the user name and password of an account that 
has sufficient permissions to update the project database. You have the option to apply these 
credentials to one database or to all selected databases.

Related topics
Using the project upgrade tool
Upgrading multiple projects
Upgrading projects to Kingdom 2023

Ready for Upgrade these databases satisfy the requirements of the Project Upgrade Tool 
and can be upgraded whenever you are ready.

Ineligible these databases do not meet the requirements of the Project Upgrade 
Tool and cannot be upgraded by the tool (usually Access-based project 
databases, which can be upgraded individually).

Complete these projects have already been upgraded to Kingdom 2023.

Failed these projects have failed a previous upgrade attempt (you can learn 
more about the upgrade failure by clicking Open Log Folder and then 
opening the log file for the specific database).

Status Ready for Upgrade, Ineligible, Complete, or Failed

Project The name of the Kingdom project

Database The project database type (Auto SSE, Manual SSE, SQL Server, Oracle)

Directory The location of the project database (click the directory link to open the 
project)
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Using the project upgrade tool
The Project Upgrade tool is a separate utility that runs independently of Kingdom. We 
recommended that you back up any projects before you upgrade them.

To upgrade multiple projects:
1. From the Start menu, click All Programs > IHS Kingdom [version] > Project Upgrade 

Tool.

2. Read and acknowledge the information on the startup window, and then click Next.

3. Click Add a directory to get started to browse to a directory containing Kingdom 
projects that you want to upgrade. Any Kingdom projects in the directory display in the 
list.

4. If you want to add additional directories with Kingdom projects, click  and browse to the 
directory you want.

5. Select the projects you want to upgrade by selecting the check box next to each project in 
the list. By default all projects are already selected.

6. If you want, you can filter the list of projects by selecting or clearing the check box next to 
the various project status types. If you have added multiple directories, you can also filter 
the list by selecting or clearing directories.

7. If a project name displays a , click the key and enter the user name and password for 
the project database. The Upgrade button remains unavailable until you have provided 
any required database credentials.

8. Click Upgrade. A progress bar displays next to each project as it is being upgraded, and 
the status changes from Ready to Complete for successful upgrades or Failed for any 
failed upgrades.

9. If you want to view the error log for any failed database upgrades, click Open Log Folder. 
Each database has it’s own log file in the log folder.

Related topics
Upgrading projects to Kingdom 2023
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Troubleshooting failed upgrades
The most common reasons for a failed project upgrade include the following:

• An unsupported version of Kingdom—you cannot upgrade projects older than Kingdom 
8.6.

• An unsupported version of SQL Server or SQL Server Express—you cannot upgrade 
projects that use SQL Server 2005 or SQL Server Express 2005.

• The project is still attached to SQL Server Express—the project may be in use by another 
Kingdom user or the project did not close properly. 

• Invalid credentials—the database user name and password you provided during the 
upgrade were incorrect or did not have sufficient permissions on the database to 
complete the upgrade.

Other, less common errors include a missing or invalid geocalc.dat file, a corrupted project 
database, or a missing coordinate reference system.

Most common issues are easy to resolve and the error message you receive provides 
resolution instructions (if you are using the Project Upgrade Tool, this information is available 
in the log file). In those cases where an upgrade issue is not easily resolved, you can contact 
Customer Care. Be sure to have the upgrade log file available before you call. To locate the 
log file, click Show Log File in the Upgrade Failed error message or Open Log Folder in the 
Project Upgrade Tool.

Related topics
Upgrading projects to Kingdom 2023
Custom Coordinate Reference System (CRS)

Upgrading Access or SQL Server Express 2005 Projects
The Project Upgrade Tool cannot upgrade Kingdom projects using an Access, SQL Server 
2005, or SQL Server Express 2005 database. You can upgrade Access projects individually, 
or you can migrate your Access projects to another database such as SQL Server Express or 
SQL Server, and then use the Project Upgrade Utility to upgrade them. You must upgrade 
any SQL Server 2005 or SQL Server Express 2005 project databases to SQL Server 2008 
R2 or later before you can upgrade the projects to Kingdom 2023. Projects using Access, 
SQL Server 2005, or SQL Server Express 2005 have a status of Ineligible in the Project 
Upgrade Tool.
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Custom Coordinate Reference System (CRS)
Project > Projection
Previous versions of Kingdom did not provide the complete list of EPSG coordinate reference 
codes, which often required users to create their own custom versions. Kingdom versions 
2015 and later provide the complete list. We recommend that you select a standard CRS 
before using a custom one. If your project still requires a custom CRS, go to Project > 
Projection > Create Custom Coordinate System. 

Related topics
Upgrading projects to Kingdom 2023
Troubleshooting failed upgrades



Kingdom Licensing
Overview
Want fewer details? See the Quick Start Guide.

Licenses for Kingdom and Kingdom Data Management support two types of licenses: 

Important: For both standalone and network licenses, the licenses are tied to a physical 
machine. To move the licenses to a different machine, you must first deactivate 
the licenses on the first computer, and then activate them on the second 
computer. You will need your EID (see below) to activate/deactivate licenses.

Always activate / deactivate licenses through the License Manager for network 
entitlements, and through the application (Kingdom) for standalone entitlements. 
Please do not activate licenses using the EMS Customer Portal unless 
instructed to do so by a customer care representative. 

• New Customers—when your Kingdom software account is set up, the primary contact at 
your company will receive an Entitlement Certificate email. The certificate contains a list 
of the products in your company’s entitlement, and an Entitlement Id (EID) which is 
required to download the software and get the license(s).

• Existing Customers—if you have renewed an existing account, you will use the original 
Entitlement Id.

Network Network licenses allow multiple users to access the same project (as 
different authors in the project) at the same time. 
A network license requires a dedicated computer to act as the license 
server, and the installation of two network licensing tools: one to install and 
manage the network licenses, and a service to provide applications access 
to the installed licenses. If you are the license administrator, see 
Downloading and installing the network licensing tools for more information.
A network license is required to employ CITRIX and Terminal server 
applications. Through these applications users can access the software 
remotely via a high-speed Internet connection.
With a network license users can check out commuter licenses to enable 
work outside of the company network or when offline.
See also Requirements and Recommendations for network licenses.

Standalone A standalone license is for a single user only and does not support 
simultaneous access to a project from different computers, even access by a 
network license. Projects can be shared only when all parties have a 
network license.
A standalone license can run multiple projects concurrently on the same 
computer, but cannot be run remotely via a virtual desktop.

http://onlinehelp.ihs.com/Energy/Kingdom/TKS_2020/Documents/QuickStartGuide.pdf
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When you start the application for the first time, you need to select which type of license you 
have: 

• Standalone—you will need your EID to download the software and activate your licenses. 

• Network—you will need the IP address or DNS name of the license server.

The base licenses required to run Kingdom are one or more of the following: Geology, 
Geophysics, (Advanced or Core) or LoadPAK (for the data loader).

The process for downloading and installing Kingdom is the same for both network and 
standalone licenses.
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Downloading and installing Kingdom
Kingdom, Kingdom Data Management, GeoSyn, and all related applications are available for 
download from the Kingdom Download page and from Sentinel EMS. The software needs to 
be installed on each user’s computer for both standalone and network licenses.

Note: The software can also be pushed out as a silent installation by an administrator. See 
Performing Silent Installations in the Installation Guide for more information.

To download Kingdom from the Kingdom Download page (link is above):
1. Select Kingdom as the product in the left pane.

2. Select the version from the dropdown list.

3. Click Download.

4. Wait for the download to complete. This takes a couple of minutes. The file is saved to 
your Downloads folder.

5. To install, when the download is complete, extract all files and double-click on The 
Kingdom Software [version] (64-bit).exe:

6. Follow the installation wizard. That’s it. You are done.

To download Kingdom from EMS (link is above):
1. Log on to Sentinel EMS using your EID.Your EID is in the Entitlement Certificate email 

that you or an administrator received from S&P Global.

2. Click Downloads in the upper-right corner.

The Download page contains all of the products in your entitlement. Each license is listed 
separately, but you only need to download Kingdom once. The Kingdom download 
includes add-on modules. Note that each product has a drop down with the same related 
documents and installers.

3. Click the download link beside Kingdom [version] (or Kingdom Data Management). The 
download file for Kingdom is Kingdom [version].zip.

4. To install, when the download is complete, extract all files and double-click on The 
Kingdom Software [version] (64-bit).exe.

5. Follow the installation wizard. No custom settings are required. 

Note: The default installation directory for application data (colorbars, templates, and 
scripts) is now C:\ProgramData\SPGlobal\KingdomSuite. When prompted, 
you can change this directory during installation. For example, some 
organizations may have a more centralized location for shared colorbars. See 
Application data directory for more information.

https://kingdomdownloads.enr.ihsenergy.com/
https://softwarelicensing.ihsmarkit.com/ems/customerLogin.html
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When the software is installed, you need to obtain your license(s):

Network If your company has a network license, you need to connect to the 
license server the first time you start Kingdom. See User 
workflow—Connecting to the license server.

Standalone If you have a standalone license, you need to activate your license 
the first time you start the application. See Activating/deactivating 
standalone licenses for detailed instructions.
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Application Data Directory
The second window of the Kingdom installation wizard, Destination Folders, allows you to 
specify a custom directory for the following:

The application data files include:

After the Kingdom installation, you can change the application data directory from the 
following:

The Kingdom Configuration Tool
The Kingdom Configuration Tool allows an administrator on the computer to copy application 
data files from earlier versions of Kingdom (for example, saved color bars and templates) to 
the new data directory. The respective directories for the application data files are:

Kingdom Software The default directory is C:\Program 
Files\SPGlobal\KingdomSuite. This location is written to the 
registry.

Application data files The default directory is 
C:\ProgramData\SPGlobal\KingdomSuite.

This location is written to the registry and is the source for all users 
on the computer, unless a user overrides the registry location for 
Application data in User Preferences > General. 

Colorbars Standard Kingdom color bars and possibly saved custom color bars.

Templates Kingdom Analytics Spotfire Templates—installed with Kingdom 
Analytics
SeismicDirect Templates—installed with Kingdom
Templates—saved templates (*.tpl files). The folder is installed with 
Kingdom.

Scripts Scripts, installed and saved, for Logs > User Scripts

Patterns Imported lithology patterns. This folder is created on import of the 
custom lithology patterns.

The Kingdom 
Configuration Tool

You must have administrative privileges. The directory location is 
written to the registry and applies to all computer users.

User Preferences A user can change the directory on the General tab in User 
Preferences. This setting applies only to the current user. The entered 
directory overrides the registry entry for this user only.

Kingdom 2019 and earlier C:\Program Files\SPGlobal\KingdomSuite
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This tool only opens during installation IF earlier versions of Kingdom have been installed on 
the computer.

After installation, a computer administrator can open the tool (Run as administrator) from the 
Start menu to copy saved files and/or change the data directory. If you are not a computer 
administrator, you can still open the tool and copy saved application data files to the new 
location, but you cannot change the location.

In the figure above, the user is an administrator, so the option Change current data 
directory, is active. If the user is not an administrator, this option is grayed out and cannot be 
selected.

You can also change the location of the data directory for your Windows login only from User 
Preferences on the General tab. You do not need to be an administrator to set your directory 

Kingdom 2020 and later C:\ProgramData\SPGlobal\KingdomSuite
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for you only. However, other users will still use the directory set by the administrator through 
the Configuration Tool.
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Network licenses
The licensing system includes the following features:

• Provides a common licensing platform for multiple products including Kingdom, Kingdom 
Data Management, Harmony, and Petra.

• Allows you to check out commuter licenses from a network license server

With a network license, the following two license tools need to be downloaded and installed:

See the License Manager help for best practices and more details.

What this means to you

License Service Install the license service on the computer designated as the license 
server.
The License Service (Sentinel RMS License Manager) administers 
the network licenses for S&P Global applications.
If you have other software products that use the Sentinel RMS 
License Manager, we recommend that you install the licensing 
software on another server to avoid compatibility issues.

Note: If you have network licenses for both Kingdom and Petra, see 
Requirements and Recommendations for license server 
requirements.

License Manager The License Manager can be installed on multiple computers with 
connectivity to the license server.
The License Manager is the interface to the License Service, where 
you can activate/deactivate licenses and monitor license usage. 

Network license 
administrators

If you are the license administrator responsible for retrieving the 
licenses, log on to Sentinel EMS (Entitlement Management System) 
using your Entitlement ID (EID) and then download and install the 
Network Licensing Tools.
See Downloading and installing the network licensing tools for 
detailed instructions.

Kingdom users When you start Kingdom for the first time you will be asked for the 
name of the license server. If you do not have this information, contact 
your license administrator. 

See User workflow—Connecting to the license server.

http://onlinehelp.ihs.com/Energy/License_Manager/1.0.0/Default.htm#html_files/license_manager.htm%3FTocPath%3DLicense%2520Manager%7C_____0
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Requirements and Recommendations
• Identify one computer on your network as the license server. For performance reasons, 

we do not recommend installing Kingdom on the computer designated as the license 
server. The server can be located on any Windows based computer. See Hardware, 
System and Database Requirements in the latest release notes for supported operating 
systems.

• If you already have a license server for Kingdom versions 2017 and earlier, you need to 
designate a different computer to be the license server for Kingdom versions 2018 and 
later. The two licensing systems cannot be on the same computer.

• If you are installing the License Service on a virtual machine, ensure that VMotion is not 
in use. The license is tied to a physical machine.

• The license service on the license server must be up and running for users to access 
licenses.

• To move the network license server to a different machine, you must first deactivate all 
licenses. All commuter licenses must also be checked in. You will need the EID to 
connect to the EMS to deactivate. See Activating/deactivating network licenses for 
details.

• Kingdom must be installed locally on each user’s computer.

• TCP Port 443 is required to activate/deactivate licenses. Open the port and provide 
connectivity to https://softwarelicensing.ihsmarkit.com/ems. This connection is only 
required during (de)activation. Port 443 can be closed once (de)activation is successful.

• Once licenses are successfully installed on the license server, UDP Port 5093 needs to 
be open between the client (e.g. Kingdom) and the license server in both the incoming 
and outgoing direction.

• Kingdom versions 2017 and earlier also use port 5093 for the license service. Therefore, 
you need a different license server for 2018 (v. 9.1.0) or later versions of the License 
Service. See the table below for examples:.

Important: Always activate / deactivate licenses through the License Manager for network 
entitlements, and through the application (Kingdom) for standalone entitlements. 

Kingdom 2019 or later| Kingdom 2018 Can be on the same license server

Kingdom 2017* | Kingdom 2018 Requires separate license servers

Kingdom 2017* | Petra 2018 Requires separate license servers

Kingdom 2018 | Petra 2018 Can be on the same license server

Petra 2017* | Petra 2018 A separate license server is recommended but not 
required.

* Version 2017 signifies version 2017 and earlier.

https://onlinehelp.ihs.com/Energy/Kingdom/TKS_Latest/Documents/Kingdom_Latest_ReleaseNotes.pdf
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Please do not activate licenses using the EMS Customer Portal unless 
instructed to do so by a customer care representative.
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Downloading and installing the network licensing tools
This document is for the network license administrator who installs the license tools, 
obtains the product feature keys, and communicates with end users on how to obtain their 
product licenses.

The network licensing tools are available for download from the Kingdom Download page 
and from Sentinel EMS. 

To download network licensing tools from the Kingdom Download page (link is 
above):
1. On the download page, select Kingdom as the product in the left pane.

2. Select the version from the dropdown list. 

3. Under Related Apps, click the down arrow beside Network Licensing Tools and click 
Download > Network Licensing.

4. Wait for the download to complete. The zipped folder contains the installation packages 
for both tools.

• License Service

• License Manage.

5. Now continue at step 4 below.

To download and install the network licensing tools from EMS (link is above):
1. Log on to the EMS using your EID.Your EID is in the Entitlement Certificate email that 

your company received from S&P Global.

2. Click Downloads in the upper-right corner.

The Download page contains all of the products included in the entitlement, including the 
required network licensing tools. Note that each product has a drop down with the same 
related documents and installers. You only need to download the network licensing tools 
once.

https://kingdomdownloads.enr.ihsenergy.com/
https://softwarelicensing.ihsmarkit.com/ems/customerLogin.html
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3. Click the download link beside Network Licensing Tools to download a zipped folder 
with the installation packages for both tools.

• License Service

• License Manager

4. Extract the files from the zipped folder:

5. Save the License Service folder to the computer designated as the license server.

Note: This computer must be a different computer than the license server used for 
earlier versions of Kingdom.

6. On the license server, open the folder and double-click the setup.exe to begin the 
installation. Follow the installation wizard. No custom settings are required.

We recommend creating a system environment variable on the license server to record 
extended usage logs. You need to restart the service after creating the variable:

• Variable name: LSERVOPTS

• Variable value: -extended-log

7. Copy the License Manager folder to the same computer and/or other computers with 
connectivity to the license server.

8. Open the folder and double-click the executable IHSMarkitLicenseManager.exe to 
begin the installation.

9. Follow the installation wizard. No custom settings are required. 

Kingdom users will need the computer name or IP address of the license server to check out 
their licenses.
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Activating/deactivating network licenses

Note: TCP Port 443 is required to activate/deactivate licenses. Open the port and provide 
connectivity to https://softwarelicensing.ihsmarkit.com/ems. This connection is only 
required during (de)activation. Port 443 can be closed once (de)activation is 
successful.

This workflow is for the network license administrator, not the end user.

To activate network licenses on the license server:

1. Open the Network License Manager:

• If you are on the license server, click Connect to connect to the localhost.

• If you are on a different computer on the network, enter the full IP address or DNS 
name of the license server and click Connect.

2. Select SOFTWARE and enter the Entitlement ID (EID) from your entitlement certificate 
email into the Entitlement Id field at the top of the page. Click Connect.

3. Still on the SOFTWARE page, select the products you want to activate and click Activate. 
The selected items are removed from this tab and are listed on the LICENSES tab.

Note: When a network user checks out an advanced base feature 
(GeophysicsAdvanced or GeologyAdvanced) a core license is also checked out. 
For this reason, the number of core Geophysics and Geology licenses on the 
LICENSES tab may be larger than you expect. See Number of licenses for an 
explanation.

4. Send the full IP address or the DNS name of the license server to the Kingdom users. 
When they start Kingdom they will need to enter this information in the Kingdom 
Network field.

To deactivate a network license:
If you want to move your network license(s) from one server to another, you need to first 
deactivate all licenses, so that they can be activated on the other server.

Note: You can only deactivate a network license if it is not currently in use. Also, all 
commuter licenses must be checked in.

1. Start the License Manager and connect to your network license server.

2. Select SOFTWARE and enter the Entitlement ID (EID) from your entitlement certificate 
email into the Entitlement Id field at the top of the page. Click Connect.

3. Click the Deactivate sub-tab, select the products you want to move to a new server, and 
click the Deactivate button. Note that you can only deactivate licenses that have no 
occupied seats or commuters.
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4. The products are now displayed in the Activate sub-tab and can be activated on a new 
server.

When the deactivation process completes, a dialog box opens indicating whether the process 
was successful or not. If the network experiences an interruption during the deactivation, a 
“Complete Partial Deactivation” button may appear. When the network is restored, clicking 
this button cleans up any artifacts caused by the interruption, and then the button disappears.

See Network License Manager for detailed information.

http://onlinehelp.ihs.com/Energy/License_Manager/1.0.0/Default.htm#html_files/license_manager.htm
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User workflow—Connecting to the license server
The following instructions are for Kingdom. For Kingdom Data Management, simply replace 
the application name. The steps are the same.

To connect to you network license server:
1. Start Kingdom.

2. Enter the full IP address or the DNS name of the Kingdom License Server provided by the 
network license administrator.

If the Kingdom License Server field is already populated, simply click Set Network 
Edition, unless the license administrator has sent a different server name. 

3. Kingdom opens and you are ready to go. 
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Related topics
Licensing Overview
Commuter licenses
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Monitoring license status
Open the License Status tab from the Kingdom Start Page. If you are in a Kingdom project, 
you can select Project > License Status, but the Kingdom project needs to close. The content 
below is for a network license. See Standalone License Control Panel. for the standalone 
version.

The License Status tab for a network license displays the base feature you are using, the 
available features, available versions (in the left panel), and the users that have licenses 
checked out. 

All Kingdom modules require a base feature license. Kingdom base features include Geology 
Advanced, Geophysics Advanced, Geology (Core), Geophysics (Core), and LoadPAK. 

In the image above, User 1 has a Geology Advanced and a Geophysics Advanced license 
checked out. The license server has a total of 5 Geophysics Advanced and 5 Geology 
Advanced licenses, so there are 3 more of each available to be checked out. The license 
server also has additional core licenses available, 5 Geology and 5 Geophysics. No core 
licenses are currently checked out. 
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If you wanted to return your advanced licenses to the server, you could select Geophysics-
Geology instead of Geophysics-Geology (ADV). You will need to restart Kingdom for these 
changes to take effect. 

To check out a commuter license, click Get Commuter License. See Commuter licenses for 
more information.

The status of the feature selected in the License Tree does not update automatically. Click 
Refresh to update the status of a selected feature.

Note: Previous versions of Kingdom did not support core and advanced base features on 
the same license server.

Commuter licenses
Commuter licensing allows you to temporarily use a network Kingdom license on a computer 
that is not connected to the network. The maximum commuter duration is 90 days.

To check out a commuter license:
1. On the Kingdom Start Page click License Status/Feature Key Maintenance to open the 

Network License Status dialog box. If you are in a Kingdom project, you can select 
Project > License Status, but the Kingdom project needs to close. 

2. In the Network License Status dialog box, click Get Commuter License.

3. In Commuter Duration enter the number of days you want the license for.

4. In the Commuter License dialog box, select any additional features that you want to 
check out. Your base feature(s) are checked out automatically.
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5. After you check out the commuter license, the License Status dialog box updates to list 
only the modules you have checked out. Other users are not displayed.

To check in the commuter license:
When you are back on the network, open the License Status dialog box and click Release 
Commuter License. 

Your commuter license expires at the end of the set duration, and is automatically released 
back to the license server. 
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Number of licenses
This information is primarily for the license administrator who activates or deactivates 
licenses through the Network License Manager.

Important: When a network user checks out a GeologyAdvanced or GeophysicsAdvanced 
seat, a core seat (Geology or Geophysics) is also checked out. The core 
licenses required for the Advanced features are included in the seat numbers on 
the LICENSE tab after you activate the licenses.

For example, in the figure below, the software purchased was the following:

• 5 Geophysics Advanced modules and 5 Geophysics core modules.

• 5 Geology Advanced modules and 5 Geology core modules

The license server is also managing Harmony and Petra licenses. See the Licenses tab topic 
in the License Manager help for more details.

Note that the license manager has Geology and Geophysics with 10 seats each instead of 5, 
because 5 of each will be checked out with the corresponding Advanced feature.

For example, if a network user selected to check out a Geophysics-Geology (ADV) license in 
the License Status dialog box that opens when Kingdom is started, the following seats would 
be used:

• 1 GeolophysicsAdvanced + 1 Geophysics

http://onlinehelp.ihs.com/Energy/License_Manager/1.0.0/html_files/licenses_tab.htm
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• 1 GeologyAdvanced + 1 Geology

The number of licenses that the network user sees in the License Status dialog box does not 
show the extra core licenses. 

See Monitoring license status for an example.
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Activating/deactivating standalone licenses
Standalone licenses do not require a license manager. With a standalone license, the license 
feature keys are retrieved from the Sentinel EMS (Entitlement Management System) and 
saved to the computer where the application is installed.

Important: You need your Entitlement ID (EID) to connect to EMS.Your EID was included 
in the Entitlement Certificate email you received from S&P Global. If you do not 
have this information, contact your license administrator or S&P Global 
representative.

If you have not downloaded the software, see Download and install the software.

Activating a standalone license:
1. Start Kingdom.

2. In the Install Kingdom License dialog box, select Standalone Edition.

3. In the Standalone License Control Panel, click Activate. 

4. In the Online License Activation or Deactivation dialog box, enter your EID and click 
Connect. You are now connected to EMS.

5. Click on the Activate tab. Select product(s) and click Activate. 

6. Exit the Online Activation or Deactivation dialog.

7. Your Standalone License Feature Keys will be displayed in the text box on the Standalone 
License Control Panel.

If the computer that the software is installed on is not connected to the internet, You can 
retrieve the license file from another computer that is connected to the internet. See 
Obtaining the license file from a different computer for details.

Deactivating a standalone license:
1. Start Kingdom.

2. In the Kingdom Start Page select Project > License Status

3. In the Standalone License Control Panel, click Activate. 

4. In the Online License Activation or Deactivation dialog box, enter your EID and click 
Connect. You are now connected to EMS.

5. Click on the Deactivate tab. Select product(s) and click Deactivate. 

6. Exit the Online Activation or Deactivation dialog.
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Obtaining the license file from a different computer
If the computer on which Kingdom is installed does not have internet access, you can retrieve 
the license file from a different computer that has internet access, and then move the license 
file to the computer where the software is installed. The Standalone License Control Panel 
has the following additional options:

File Use this option if you have obtained a feature key file from Customer Care.

1. Save the feature key file (lsercrc.zip) to your computer and extract it.

2. Click Browse Feature Key File, browse to the extracted file and click Open. 
Your feature keys populate the Feature key box.

3. Click Apply.

4. Verify your licenses on the Feature Information tab.

Note: You can also copy the feature keys from the text file and paste into the 
Feature Key box.

EMS Use this option if the computer with Kingdom installed is not online. This method 
requires:
• a different computer with online access
• EID from the Entitlement Certificate email
• Computer Code from the computer with Kingdom installed (outlined in red 

below)
• The EMS URL displayed in the Standalone License Control Panel 

See Retrieving a license file from the Sentinel EMS for instructions.

Email Copy your Computer Code (outlined in red in the figure below). Then click the 
email link, customercare@ihsmarkit.com. Paste the computer code into the 
subject field and send. Customer Care will send you your feature key lservrc 
file. Follow the steps for connecting by File above.
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.

Feature Information Tab
After you have installed your feature keys, click the Feature Information tab of the 
Standalone License Control Panel to verify the features licensed as well as the start and 
expiration dates of each feature.
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Retrieving a license file from the Sentinel EMS
If you retrieve your licenses by connecting directly to the Sentinel EMS, the system will 
generate a license file (lservrc) . You can then use this file in the Standalone License 
Control Panel to install the feature keys.

You may need to use this option, rather than the Online Activation option, if the computer 
where Kingdom is installed is not connected to the internet. To use this option, you need a 
computer with online access and the following:

1. On the computer connected to the internet, connect to Sentinel EMS.

2. On the Customer Login page, select EID as the login name, enter the Entitlement ID, 
and click Login.

3. In Sentinel EMS window, select the products you want to activate and click Activate.

4. In the Activate Product(s) window, enter the Computer Code into the field outlined in red 
in the image below.

5. Click Activate.

6. The EMS generates the License String. You have 3 options:

7. Copy the lservc.zip file received from the EMS to the computer where Kingdom is 
installed and extract the file. This file can be deleted after the licenses has been activated.

8. Start Kingdom.

9. In the Standalone License Control Panel, click Browse Feature Key File.

10. Browse to and select the lservrc file and click Open.

11. The license string (Feature keys) populate the Standalone License Control Panel. Click 
Apply.

12. Verify your licenses on the Feature Information tab.

Sentinel EMS URL  https://softwarelicensing.ihsmarkit.com/ems/
customerLogin.html

EID Included in the Entitlement Certificate email

Computer Code From the Standalone License Control Panel on the computer 
where Kingdom is installed: 
Kingdom Start Page > File > License Status

Save to File The license string is saved to a file named lservrc.

Append to File If you are adding modules to an existing file, browse to the 
lservrc file and click OK.

E-mail Specify and email address, and the lservrc file will be sent to 
that address.

https://softwarelicensing.ihsmarkit.com/ems/customerLogin.html
https://softwarelicensing.ihsmarkit.com/ems/customerLogin.html
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Changing your license configuration
The License Configuration dialog box allows you to change the license server, and/or switch 
between network and standalone if your company has both. However, remember that a 
commuter license acts as a standalone license, so you should not need to switch from 
network to standalone.

These workflows assume that a standalone license has been activated on the user’s 
computer, and that the user also has the IP address or name of a valid license server. See 
the following topics for details on activating/deactivating:

• Activating/deactivating standalone licenses.

• Activating/deactivating network licenses.

Note: If you have a commuter license checked out, you need to release the commuter 
license before you can switch to a standalone license.

To switch from a network license to a standalone:
1. On the Kingdom Start Page select Project > License Configuration.

2. Click Enable Standalone License. The application must shut down for the changes to 
take effect.

3. Start Kingdom. 

In the License Configuration dialog box, the license server name remains in the License 
Server field, which you can edit if needed when going back to a network license.

To switch from standalone to network:
1. On the Kingdom Start Page select Project > License Configuration

2. Click Disable Standalone License. The application must shut down for the changes to 
take effect.

3. Start Kingdom. A network license is checked out from the license server. 

To confirm which base license you are using, from the Start Page, select Project > 
License Status.

Note: Disabling a standalone license only disables the standalone license on that machine 
to allow you to temporarily use a network license. It does not return it to the server for 
another user to activate. See steps 1-5 below on how to deactivate a standalone 
license.

To transfer a standalone license to another computer:
1. On the Kingdom Start Page select Project > License Status.

2. Click Online Activation. If you did not select Remember Me previously, you will need to 
enter your EID from the Entitlement Certificate email.
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3. In the Online License Activation or Deactivation dialog box, select the Deactivate tab.

4. Select the licenses you want to deactivate and click Deactivate. 

5. Exit the dialog box and close Kingdom.

6. On the other computer, follow steps 1-2 above. 

7. In the Online License Activation or Deactivation dialog box, select the Activate tab.

8. Select the licenses you want to activate and click Activate.
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Performing Silent Installations
Overview
Kingdom and Kingdom Data Management provide the ability to perform silent installations 
using the Microsoft Installer (MSI) installation file. Kingdom also provides the ability to 
perform silent patch updates using the Microsoft Patch (MSP) file.These silent installations 
and patches are useful for companies with controlled IT environments that centrally manage 
and deploy software to user computers.

Microsoft Windows installer service
The Microsoft Windows Installer Service (msiexec.exe) is a service provided by Microsoft 
and included in most Microsoft operating systems. This is the service you use to perform 
software installations with MSI and MSP files.

Command Line options and properties
For a list of the command line options available to the Microsoft Windows Installer Service 
(msiexec.exe), see the following article available from Microsoft:

http://msdn.microsoft.com/en-us/library/Aa367988.

MSI Properties
The Microsoft Windows Installer Service has many properties for which you can define 
values. An important property you are likely to use is the INSTALLDIR property, which defines 
the installation directory for the silent installation of an application. For example:

INSTALLDIR=”C:\Program Files\SPGlobal\KingdomSuite”

The DATADIR property is optional. This directory holds Kingdom files such as colorbars and 
templates. The default location for DATADIR is 
C:\ProgramData\SPGlobal\KingdomSuite]

DATADIR="C:\MyData\KingdomSuite”

MSI Use the MSI file (The Kingdom Software 2023 (64-bit).msi) with 
the Microsoft Windows Installer application (msiexec.exe), including all the 
available command line options available to the installer. 

For more information about the Microsoft Windows Installer and its command 
line options, refer to the available Microsoft documentation. Before installing 
Kingdom 2023 using the MSI file, you must first install the software 
prerequisites. For more information, see Installing prerequisites.

MSP Use the MSP file (TKS_[Kingdom Version]_[Patch Version].msp) with 
the Microsoft Windows Installer application (msiexec.exe).

http://msdn.microsoft.com/en-us/library/Aa367988
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You use properties at the command line for silent installations. Keep in mind that property 
names are case sensitive.

Sample command lines
Here are some sample command lines for the silent installation of Kingdom. These are 
provided for reference only. Your own command line requirements may differ significantly.

Note: The command needs to be run from the command prompt or a process with 
administrative privileges.

Kingdom

Kingdom Components

Install to default 
location

msiexec.exe /i “<path to msi>\The Kingdom Software 2023 
(64-bit).msi” /quiet

Install to custom 
location

msiexec.exe /i “<path to msi>\The Kingdom Software 2022 
(64-bit).msi” INSTALLDIR=”C:\MyApps\KingdomSuite” 
DATADIR="C:\MyData\KingdomSuite” /quiet

Install patch msiexec /p TKS_[Kingdom Version]_[Patch Version].msp 
REINSTALLMODE=vomus REINSTALL=ALL /quiet

Install patch to custom 
location

msiexec /p TKS_[Kingdom Version]_[Patch Version].msp 
INSTALLDIR=”C:\MyApps\KingdomSuite” 
DATADIR="C:\MyData\KingdomSuite” REINSTALLMODE=vomus 
REINSTALL=ALL /quiet

Install to default location msiexec.exe /i “<path to msi>\The Kingdom Software 2022 
Components.msi” /quiet

Install to custom location msiexec.exe /i “<path to msi>\The Kingdom Software 2022 
Components.msi” INSTALLDIR=”C:\MyApps\KingdomSuite” /
quiet

Install patch msiexec /p TKSC_[Kingdom Version]_[Patch Version].msp 
REINSTALLMODE=vomus REINSTALL=ALL /quiet

Install patch to custom 
location

msiexec /p TKSC_[Kingdom Version]_[Patch Version].msp 
INSTALLDIR=”C:\MyApps\KingdomSuite” REINSTALLMODE=vomus 
REINSTALL=ALL /quiet
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Kingdom Petrophysics
After installing Kingdom, you need to install Kingdom Petrophysics. This component is 
required: 

Kingdom ML Models

Log files
The Microsoft Windows Installer creates log files for each installation in the installing user’s 
Temp directory: C:\Users\<UserID>\AppData\Local\Temp\nnnnnnnn.log. The log file 
name is automatically generated and is different for each installation.

Related topics
Extracting the MSI file
Extracting the MSP file for patch updates
Extracting the Harmony Connection Add-on (HCA) prerequisite package

Install to default 
location

KP.exe /VERYSILENT /NORESTART /LOG /CLOSEAPPLICATIONS /
FORCECLOSEAPPLICATIONS /NOICONS /DIR=“C:\Program 
Files\SPGlobal\KingdomSuite\TKS 2022\KP"

Install to custom 
location

KP.exe /VERYSILENT /NORESTART /LOG /CLOSEAPPLICATIONS /
FORCECLOSEAPPLICATIONS /NOICONS /
DIR=“C:\MyApps\KingdomSuite\TKS 2020\KP”

Install patch to default 
location

KP_Update.exe /VERYSILENT /NORESTART /LOG /
CLOSEAPPLICATIONS /FORCECLOSEAPPLICATIONS /NOICONS /
DIR=“C:\Program Files\SPGlobal\KingdomSuite\TKS 
2022\KP"

Install patch to custom 
location

KP_Update.exe /VERYSILENT /NORESTART /LOG /
CLOSEAPPLICATIONS /FORCECLOSEAPPLICATIONS /NOICONS /
DIR=“C:\MyApps\KingdomSuite\TKS 2022\KP”

Install to default 
location

msiexec.exe /i “<path to msi>\Kingdom ML Models 
[MajorVersion.MinorVersion].msi” /quiet

Install to custom 
location

msiexec.exe /i “<path to msi>\Kingdom ML Models 
[MajorVersion.MinorVersion].msi” 
DATADIR="C:\MyData\KingdomSuite” /quiet
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Extracting the MSI file
The Kingdom, and Kingdom Data Management (KDM) MSI files are contained in the 
standard installation executables and must be extracted before you can use them for silent 
installations. The standard installation executables for each application are available for 
download from the IHS Kingdom website at kingdom.ihs.com as well as on the Kingdom USB 
drive:

To extract the Kingdom or Kingdom Data Management MSI file:

1. Download the installation executable from the Kingdom Download page or copy the 
installation executable from the installation USB drive.

1. At a command prompt, change directories to the location of the application executable 
(.exe) file.

2. Type one of the following, depending on the program you want to extract:

• “The Kingdom Software 2023 (64-bit).exe” /stage_only

• “Kingdom Data Management 2023 (64-bit).exe” /stage_only

3. Press Enter.

4. When prompted, select a destination folder where you want to extract the MSI file.

5. Click Finish to complete the extraction.

The MSI extraction creates several folders with different GUIDs. These folders contain the 
Kingdom or Kingdom Data Management MSI as well as MSI and .exe files for all the 
prerequisite software.

You can move these files to any location you need to perform silent installations.

Note: You can also extract the MSI file directly from the installation USB drive without 
needing to copy the installation executable to a computer. Here is a sample command 
line for extracting the Kingdom MSI file from the USB drive:

“<USBdriveRoot>\KingdomSoftware\Kingdom\x64\The Kingdom Software 2023 
(64-bit).exe” /stage_only

If you need more information about extracting content from the installation executable, refer 
to the InstallShield support documentation.

Related topics
Installing prerequisites

Kingdom <USBdriveRoot>\KingdomSoftware\Kingdom\x64\The Kingdom 
Software 2023 (64-bit).exe

KDM <USBdriveRoot>\KingdomDM\x64\Kingdom Data Management 2023 (64-
bit).exe

http://helpnet.flexerasoftware.com/installshield19helplib/helplibrary/SteSetupexeParam.htm
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Extracting the MSP file for patch updates
The Kingdom MSP file is contained in the standard installation executable and must be 
extracted before you can use it for silent upgrade. The standard upgrade executable is the 
following:

Note: The patch can only be extracted on the system with the base release installed.

To extract the Kingdom MSP file:

1. Download the installation executable from the EMS portal or the Kingdom Download 
page.

1. At a command prompt, change directories to the location of the application executable 
(.exe) file.

2. Type “TKS_[Kingdom Version_<patch version>.exe” /stage_only

3. Press Enter.

4. When prompted, select a destination folder where you want to extract the MSP file.

5. Click Finish to complete the extraction.

The extraction folder contains the Kingdom MSP file and the KP_Update.exe file.

You can move these files to any location you need to perform silent patch updates.

If you need more information about extracting content from the patch executable, refer to the 
InstallShield support documentation.

Related topics
Installing prerequisites

Kingdom <Path to patch installer>\TKS_[Kingdom Version]_<patch 
version>.exe

http://helpnet.flexerasoftware.com/installshield19helplib/helplibrary/SteSetupexeParam.htm
https://kingdomdownloads.enr.ihsenergy.com/
https://kingdomdownloads.enr.ihsenergy.com/
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Extracting the Harmony Connection Add-on (HCA) 
prerequisite package
The Harmony prerequisite installer files, which allow Spatial Explorer to open Harmony 
projects, are included in the standard installation executable and must be extracted before 
you can use it for silent upgrade. 

Note: the HCA package is only required when the Kingdom users want to open Harmony 
projects in Spatial Explorer on a computer that does not have Harmony installed.

The standard upgrade executable is the following:

To extract the Harmony Connection Add-on prerequisite package:
1. Download the installation executable from the EMS portal or the Kingdom download 

page.

2. At a command prompt, change directories to the location of the application executable 
(.exe) file.

3. Type “Harmony Connection Addon.exe” /stage_only

4. Press Enter.

5. When prompted, select a destination folder where you want to extract the prerequisite 
files to.

6. Click Finish to complete the extraction.

The extraction folder contains the prerequisite installer files.You can move these files to any 
location you need to perform silent patch updates.

If you need more information about extracting content from the patch executable, refer to the 
InstallShield support documentation.

Related topics
Installing prerequisites

Harmony Connection Addon <Path to patch installer>\Harmony Connection 
Addon.exe

https://docs.revenera.com/installshield19helplib/helplibrary/SteSetupexeParam.htm
https://kingdomdownloads.enr.ihsenergy.com/
https://kingdomdownloads.enr.ihsenergy.com/
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Installing prerequisites
Kingdom and Kingdom Data Management have several software prerequisites that must be 
in place to successfully install either application. The standard installation executables 
include these prerequisites, but they are not installed if you perform a silent installation with 
an MSI file. You must install each prerequisite prior to installing Kingdom or Kingdom Data 
Management. When you extract the MSI file from the standard installation executable, the 
prerequisite software is also extracted. For more information, see Extracting the MSI file.

Prerequisites for Kingdom
Prerequisite Sample Command Line

Microsoft .NET Framework 4.8 
(ndp48-x86-x64-allos-enu.exe)

ndp48-x86-x64-allos-enu.exe "/q:a /
C:\"install /q /norestart\" /norestart"

Microsoft OLE DB Driver for SQL Server 
18.3.0.0 (x64) 
(msoledbsql_x64.msi)

msiexec.exe /i msoledbsql_x64.msi 
IACCEPTMSOLEDBSQLLICENSETERMS=YES /qn

Microsoft SQL Server Management Objects 
10.00.2531 (x64) 
(SharedManagementObjects_amd64.msi)

msiexec.exe /i 
SharedManagementObjects_amd64.msi /qn /
passive

Microsoft SQL Server System CLR Types 
10.00.2531 (x64) or greater
(SQLSysClrTypes_amd64.msi)

msiexec.exe /i SQLSysClrTypes_amd64.msi /
qn /passive

Microsoft Visual C++ 2010 SP1 
Redistributable Package (x64)
(vcredist2010SP1_x64.exe)

vcredist2010SP1_x64.exe /q /norestart

Microsoft Visual C++ 2012 Update 4 
Redistributable Package (x64)
(vcredist2012Update4_x64.exe)

vcredist2012Update4_x64.exe /q /norestart

Microsoft Visual C++ 2015 Update 3 
Redistributable Package (x64)
(vcredist2015Update3_x64.exe)

vcredist2015Update3_x64.exe /q /norestart
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Prerequisites for Kingdom Data Management

Prerequisites for Harmony Connection Add-on

Prerequisite Sample Command Line

Microsoft .NET Framework 4.8 
(NDP48-x86-x64-AllOS-ENU.exe)

ndp48-x86-x64-allos-enu.exe "/q:a /
C:\"install /q /norestart\" /norestart"

Microsoft OLE DB Driver for SQL Server 
18.3.0.0 (x64) 
(msoledbsql_x64.msi)

msiexec.exe /i msoledbsql_x64.msi 
IACCEPTMSOLEDBSQLLICENSETERMS=YES /qn

Microsoft SQL Server Management Objects 
10.00.2531 (x64) 
(SharedManagementObjects_amd64.msi)

msiexec.exe /i 
SharedManagementObjects_amd64.msi /qn /
passive

Microsoft SQL Server System CLR Types 
10.00.2531 (x64) or greater
(SQLSysClrTypes_amd64.msi)

msiexec.exe /i SQLSysClrTypes_amd64.msi /
qn /passive

Microsoft Report Viewer 2010 Redistributable
(ReportViewer.exe)

ReportViewer.exe /q /norestart

Prerequisite Sample Command Line

Microsoft Visual C++ 2015-2019 
Redistributable (x64)
(VC_redist.x64.exe)

VC_redist.x64.exe /install /quiet /
norestart

ODBC Driver 17 for SQL Server
(msodbcsql.msi)

msiexec.exe /i msodbcsql.msi 
IACCEPTMSODBCSQLLICENSETERMS=YES /qn

SQL Server 2019 Express LocalDB
(SqlLocalDB.msi)

msiexec.exe /i SqlLocalDB.msi 
IACCEPTSQLLOCALDBLICENSETERMS=YES /qn
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Related Apps and Resources
Overview
Kingdom, Kingdom Data Management, and all related applications are available for 
download from the Entitlement Management System (EMS). 

The download process is the same for all applications and document sets. 

Note: You need the Entitlement ID (EID) to log on to the EMS. The EID was included in the 
Entitlement Certificate sent to the primary contact at your company. If you do not 
know the name of the primary company contact, call Customer Care.

The following related applications are available from the EMS. The name of each installation 
package that you download is included::

Related Apps

SQL Server Express IHS Kingdom SQL Server [version] Express Installer.exe

SQL Server Express is a free, lightweight version of SQL Server 
with a specific configuration to work with Kingdom. 

SQL Server Management 
Studio

SQLManagementStudio_x64_ENU.exe

SQL Server Management Studio is an integrated environment for 
accessing, configuring, managing, administering, and developing 
all components of SQL Server.

Demo Projects Kingdom_Demo_Projects_[version].zip

The default installation directory for the demo projects is 
C:\Kingdom Demo Projects.

The demo projects use SQL Server Express for the project 
database.

Kingdom Gateway [version] 
for Petrel [version]

IHSKingdomGatewayInstaller[version].[version].zip

Provides direct connectivity between Kingdom and Petrel 
software. 

Administrator Console KingdomAdminConsoleSetup.exe

Allows an administrator to specify access to Kingdom projects 
based on Active Directory permissions.

Frac Explorer Database Frac_Explorer_Database.bak

The Frac Explorer database provides the required database 
schema for your completions data.

http://onlinehelp.ihs.com/Energy/FracExplorer/FE_2018/#fracexplorer/fr_using_management_studio.htm
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To download and install:
1. Log on to the EMS using your EID at https://softwarelicensing.ihsmarkit.com/ems/

customerLogin.html.

2. Click Downloads in the upper-right corner.

The Download page contains all of your entitlements. Each license is listed separately. All 
related applications and resources are listed under each entitlement, but you only need to 
download once. 

3. Click the Download link beside the related application or resource that you want to 
download. 

4. When the download is complete, extract all files (if zipped) and double-click on the 
executable. 

5. Follow the installation wizard. No custom settings are required.

Frac Data Web Service IHS Markit Frac Data Web Service [version].exe

The Frac Data web service enables connectivity between the Frac 
Explorer application and the Frac Explorer database.

Resources

Installation Guide Guidance for what database to select and detailed instructions for 
installing and updating Kingdom and other related applications. It 
also includes information about licensing requirements and 
management.

What’s New Details about the new features and enhancements in the latest 
version.

Quick Start Guide Brief instructions on how to obtain and activate your licenses for 
the latest version. A full version of the same instructions is 
available in the Kingdom Installation Guide.

Documentation (PDF 
versions)

Printable versions of all available Kingdom software user guides. 
This information is also available through the Help menu of each 
application.

Which version of SQL 
Server Express should I 
download?

Information to help you select the best version of SQL Server 
Express. SQL Express databases are not backward compatible so 
it is important to review this information before installing or 
upgrading.

http://onlinehelp.ihs.com/Energy/FracExplorer/FE_2018/#fracexplorer/fr_installing_the_web_service.htm
https://softwarelicensing.ihsmarkit.com/ems/customerLogin.html
https://softwarelicensing.ihsmarkit.com/ems/customerLogin.html
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About the Kingdom Demo Projects
The demo projects require approximately 700 MB of space. The demo projects use SQL 
Server Express for the project database, so you need to install SQL Server Express 2014 or 
later to open the demo projects. 

The following projects and data are available:

Note: The demo projects have SQL Server Express databases. You need to install SQL 
Server Express on your machine before you can open the Demo Projects. For 
Kingdom version 2022, the demo projects are using SQL Server 16 Express. See 
About SQL Server Express for details.

BEG This Bureau of Economic Geology project contains the Stratton Field 3D 
seismic survey with wells and requires approximately 142 MB.

Golden This Golden Geophysical project contains one 3D survey and four 2D line 
and requires 160 MB.

Sooner This US Department of Energy and Diversified Operating Corporation 
reservoir management project contains one 3D survey with wells and 
requires 220 MB.

Data This folder contains the various data items that can be used with the data 
loading tutorials and for general data loading practice and requires 183 MB.

Shape Files This folder contains culture layers for the Sooner Project and requires 142 
MB of space.
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Installing Kingdom from a USB Drive
The information in this chapter applies if you plan to install Kingdom or Kingdom Data 
Management from the USB drive and includes the following:

• Kingdom software contents

• Kingdom Installation Manager

The default installation directory is C:\Program Files\SPGlobal\KingdomSuite. Each 
product has its own subfolder within the KingdomSuite folder.

Please note that the fastest and easiest method to obtain and install the latest Kingdom 
update is to download it from the Entitlement Management System (EMS). You will need your 
Entitlement ID (EID) to log on. Licenses are only available from the EMS. See Kingdom 
Licensing for more information.
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Kingdom software contents

Kingdom software contents
The Kingdom Software USB drive contains the installation files for the following applications 
and files:

Related topics
Kingdom Installation Manager
Installing Kingdom from a USB Drive

AdministratorConsole The installation files for the Kingdom Administrator Console.

InstallPages Files and images used by the Kingdom Installation Manager

KingdomDM The installation files for Kingdom Data Management

KINGDOMSoftware The installation files, installation documentation, and demo 
projects for the Kingdom software.

Product Documentation PDF files of the user manuals for all products. These files are 
copied to your computer during the Kingdom installation. You can 
read PDF files with Adobe Acrobat Reader. Download for free 
from Adobe.

SupportFiles Contains the installation and supporting files for the following 
applications:

• Microsoft—includes .NET, Report Viewer, and Microsoft SQL 
Server - Express edition.

• SQLExpress—The Kingdom installer for Microsoft SQL Server 
- Express edition.

AUTORUN.INF Contains setup information for the installer.

Release Documents Contains the following product documentation:
• QuickReferenceGuide.pdf—a brief version of how to obtain 

and activate your licenses for the latest version.

• ReleaseNotes.pdf—important information about installation, 
compatibility, configuration, enhancements, fixed bugs, and 
known problems.

• WhatsNew.pdf—an introduction to the new features and 
functionality in Kingdom and Kingdom Data Management.

Setup.exe The application executable. Double-click to start the Kingdom 
Installation Manager.

TKS.config Configuration file for the installation.

https://acrobat.adobe.com/us/en/acrobat/pdf-reader.html
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Kingdom Installation Manager 

Kingdom Installation Manager
Use the Kingdom Installation Manager to install Kingdom, Kingdom Data Management, 
related Kingdom applications, and all third party software from the Kingdom USB drive. 

The Kingdom Installation Manager contains the following tabs:

Related topics
Kingdom software contents
Installing Kingdom from a USB Drive

Install Kingdom
The Install Kingdom tab includes the following items:

Install Kingdom Install Kingdom and the Kingdom Demo Projects.

Install Kingdom DM Install Kingdom Data Management or request a trial license.

View Resources View product release and Help documentation

Install Third Party 
Software

Install AppSight, Adobe Reader, SQL Server Express, and SQL 
Management Studio.

Applications Install any of the following related applications. 
• License Service—required for network licenses

See Network licenses for more information.

• License Manager —required for network licenses

• The Administrator Console

Install Kingdom Software Click to start the installation wizard. Before you can run 
Kingdom, you need to obtain and install the feature keys that 
control the licensing. See Kingdom Licensing for details.

Install Demo Projects Click to start the installation wizard for the demo projects 
included with Kingdom.

View Installation Guide The installation guide is in PDF format and requires a PDF 
viewer.

Request a Trial License Click to connect to the Product Evaluation page. Enter the 
required information and send the form to us.
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Kingdom Installation Manager

Install Kingdom Data Management (Kingdom DM)
Kingdom DM is a data management and data transfer tool that allows you to work more 
efficiently when managing data.

Your Kingdom and Kingdom DM versions must match. For example, if you have installed 
Kingdom 2023 64-bit, you must install Kingdom DM 2023 64-bit.

The Install Kingdom DM tab includes the following items:

Related topics
Kingdom Data Management
Kingdom Installation Manager

View Resources
The View Resources tab provides quick access to release documents and the full product 
documentation, all in PDF format.

Install Kingdom DM Click to start the installation wizard. Kingdom DM requires a 
separate license.

View Installation Guide The installation guide is in PDF format and requires Adobe 
Reader.

Request a Trial License click to connect to the Product Evaluation page. Enter the 
required information and send the form to us.

Release Notes Provides important information about the current version 
including fixed bugs, known issues, and installation information. 
Please read this document before installing or reinstalling the 
software.

What’s New Includes details the new features and enhancements in the latest 
version.

My Account Links to the many resources available to you on the Entitlement 
Management System and the Kingdom web site.

Product Documentation Provides PDF versions of all available Kingdom Software user 
manuals. This information is also available through the Help 
menu of each application: Help > Help Center.

http://kingdom.ihs.com
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Kingdom Installation Manager 

Install Third Party Software
Three third party applications are available from the Install Third Party Software tab.

Related topics
Kingdom Installation Manager

Microsoft SQL Express Installs Kingdom’s customized version of SQL Server - Express 
edition.

SQL Management Studio The Management Studio provides tools to access, configure, 
manage, and administer SQL Server Express.
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Kingdom Installation Manager
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Installing Third Party Software
Overview
Three third-party applications are available from the Entitlement Management System and 
from My Account at kingdom.ihs.com:

• the Kingdom configured version of SQL Server Express

• Microsoft SQL Server Management Studio

For SQL Server Management Studio and Adobe Reader, please see the product’s 
documentation. 

About SQL Server Express
The Kingdom version of SQL Server Express includes an SMTKINGDOM instance which is 
pre-configured with a user name and password that Kingdom uses to access the database.

Important: Before installing SQL Server Express, read Understanding SQL Server Express.

Installation of this instance should not affect existing instances of SQL Server Express 
installed by other programs.

The Default installation location is:

C:\Program Files\Microsoft SQL Server

If you select an alternate destination location, the folder SMTKINGDOM_DATA is not 
automatically created. First create this folder in the desired location and then direct the 
InstallShield Wizard to this folder.

When installation of the instance is complete, the SQL Server Express Service Configuration 
dialog box opens. Read the contents of this dialog box carefully to determine whether you 
want a local or a network configuration. You can also refer to SQL Server Express Service 
Configuration for more information.

Network database Instance
If you decide to install your SMTKINGDOM instance of SQL Server Express on your network 
to support access for multiple Kingdom users to a single instance, you or your network 
administrator need to create a service account for SQL Server Express to use to access the 
Kingdom projects on network computers. This is not necessary if you plan to install SQL 
Server Express on the same computer where you have your Kingdom projects. For detailed 
instructions on configuring SQL Server Express on your network, see Network Project—
Network Database Instance.



68 © 2023 S&P Global. All rights reserved. Reproduction in whole or part without permission is prohibited.

Troubleshooting
This section addresses common problems you may encounter when connecting to the SQL 
Server Express database or starting the SQL Server Express service:

• Connecting to your SQL Server Express database

• Unable to start the SQL Server Express service

Connecting to your SQL Server Express database
The following information gives troubleshooting tips for a database migration to SQL Server 
Express. These tips also apply to problems opening an existing SQL Server Express 
Kingdom project.

My Kingdom SSE instance is not listed—when creating a project, you cannot see your 
SQL Server Express instance in the list of available instances.

Error occurred connecting to the database—a general error message when trying to 
create or open a SQL Server Express project could be caused by a number of reasons.

Connection requirements for Auto SSE—if you received an error message when creating 
an Auto SSE project stating that the instance did not have adequate permission to read/
write to the project database file, you may need to change permissions on the project 
directory or change the log on account of the SQL Server (SMTKINGDOM) service.

My Kingdom SSE instance is not listed
If you have already installed the SMTKINGDOM instance of SQL Server Express, and you 
still cannot see your instance in the drop down list as in the figure below, there are several 
possible causes.

Before troubleshooting, try typing the installed SQL Server Express instance into the SQL 
Server Connect field. Remember, the instance  will have \SMTKINGDOM at the end.

Click OK to continue.
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If you receive an error message see Error occurred connecting to the database

Error occurred connecting to the database
If you get “An error occurred connecting to the database. Would you like to try again?”, 
Click No and try the following solutions:

Problem 1: One of the SQL Server services is not running.

Solution 1: Open the Administrative Tools on the computer where SQL Server Express is 
installed and start the SQL Server service(s). The steps below are for a computer running 
Windows 7. There may be slight differences for different Windows operating systems.

1. Click Start > Control Panel > Administrative Tools.

2. Double-click Services.

3. Scroll down to locate the SQL Server services. Check that SQL Server (SMTKINGDOM) 
and the SQL Server Browser services are started.

4. To start a service, right-click the service in the Status column and select Start.

5. Try opening the Kingdom project again.

Problem 2: The TCP/IP protocols is not enabled.

If the SQL Server Express instance is not local (on your computer), the TCP/IP protocol 
on the remote database instance must be enabled. If the SQL Server Express instance is 
on your machine, this is not an issue.

Solution 2: On the computer where SQL Server Express is installed, open the SQL Server 
Configuration Manager and enable the TCP/IP protocol:

1. Click Start > Programs > Microsoft SQL Server 2008 R2 > Configuration Tools > SQL 
Server Configuration Manager.

2. Under SQL Server Network Configuration, select Protocols for SMTKINGDOM.
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3. In the right panel, check if the TCP/IP protocol is enabled. If it is disabled as in the figure 
above, right click Disabled and select Enable.

4. Restart the database service:

a. In the same Configuration Manager, select SQL Server Services in the left panel. 

b. In the right panel right click SQL Server (SMTKINGDOM) and select Restart.

Note: The default status for this protocol is enabled.

Unable to start the SQL Server Express service
There are a number of reasons why the SQL Server Express service is unable to start. 
Microsoft returns 24 possible reasons. However, the following are the most common:

The user password is not valid Re-enter the password in the Server Configuration dialog 
box and retry.

The user has not been granted 
local “logon as a service” rights

If prompted that the user  be added to the local “logon as a 
service” group, click OK.

The domain user is not a 
member of a Group that has 
“logon as a service” rights.

Contact your domain administrator. See Network Project—
Network Database Instance for detailed steps.

The user is not in the 
Administrator group on the local 
computer

Add the service account user to the computer where the SQL 
Server Express instance is installed and add to Administrator 
Group

The user logged in to the 
computer is not a local 
administrator

You must be a member of the Administrator group on the 
computer. Contact your domain administrator for assistance.
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SQL Server Express Service Configuration
What is your Working Environment?
Note: You must be an administrator on your computer to run the service configuration 

application. 

One of the following configuration options is required for the Auto SQL Server Express 
configuration and is highly recommended for the Manual configuration:

Local

Other users in a work group or network that have permissions to access this computer can 
also work in the Kingdom projects.

Network

You need to get service credentials from your domain administrator before continuing.

See Unable to start the service for troubleshooting tips if you get an error message after 
trying to start the service with the entered log on credentials.

Projects Kingdom projects are on your computer or on a colleague’s 
computer.

Users You are a single user or have a small work group.

SQL Server Express 
Service

Install SQL Server Express on the same computer as the Kingdom 
projects. Accept Local as the configuration. Click OK in the SQL 
Server Express Service Configuration dialog box to exit.

Projects Kingdom projects are on a shared resource on the network.

Users The Kingdom projects and SQL Server Express instance may be on 
different machines. Multiple users may connect to the same SQL 
Server Express instance.

SQL Server Express 
Service

Install SQL Server Express on a network computer - not on your 
workstation. 
This configuration requires a Network Project—Network Database 
Instance solution.
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Note: If you need help, contact Commodity Insights Client Services at 
ci.support@spglobal.com or at one of the numbers below: 

When connected, select Option 3 (Commodity Insights) and then Option 1 for Kingdom.

Also check out The Learning Center where you will find an ever-expanding selection of 
product training, fundamentals training, and virtual event opportunities.

Americas +1 800 597 1344

Asia Pacific +60 4 296 1125

Europe, Middle East, Africa +44 (0) 203 367 0681

https://learning.ihsmarkit.com/
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Network Project—Network Database Instance
You are in a network environment when your project and your SQL Server Express 
(SMTKINGDOM) instance are both on your network - not on your workstation. This 
configuration supports multiple projects on multiple computers connecting to a central SQL 
Server Express instance.

See What is your Working Environment? for local and network criteria.

Your network administrator needs to do the following:

1. Create user (service account).

2. Add the “Log on as a service right” to the user account.

3. Grant the service account Full Control privileges to Kingdom project directories.

4. Add the service account user to the computer where the SQL Server Express instance is 
installed and add to Administrator Group.

5. Set the service account as the Log On account for the SQL Server (SMTKINGDOM) 
service.

Create user (service account)
Prerequisites:

• Microsoft Administrative Tool Pack is installed on a machine in the domain or you have 
access to the domain controller.

• You have a domain administrator account or service account with permissions to create 
users and modify the default domain policy to create the service account. 

Create the user (service account)

1. On a Windows Domain Controller, open Administrative Tools and click Computer 
Management.

2. Expand Your Domain.

3. Right click Users and select New User.

4. Enter the user account information and click Next.

5. Enter a password and confirm the password.

6. Select Password never expires.

7. Click Create and then Close.

Add the “Log on as a service right” to the user account
1. On a Windows Domain Controller, open Administrative Tools and select Domain 

Security Policy.

2. In the console tree, expand Local Policies and then User Rights Assignment.

3. In the details pane, double-click Log on as a service.
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4. If this security setting has not yet been defined, select the Define these policy settings 
check box.

5. Click Add User or Group and then add the user (service) account you created.

Grant the service account Full Control privileges to Kingdom project directories
Add the service account to the group(s) that have Full Control access to the Kingdom project 
directories—or—share the Kingdom project directories to the user account and give Full 
Control access. For the second option, see How do I share my project directories?

Add the service account to the group(s) that have Full Control access

1. On the Windows Domain Controller, select Start > Programs > Administrative Tools > 
Active Directory Users and Computers.

2. Click Groups to display existing groups. 

3. Right click the selected group and select Add to Group.

4. Click Add.

5. Make sure Service Accounts is displayed under Select this object type and that your 
Domain is displayed under From this location.

6. Enter the name of the service account that you created and click Check Names.

7. When the account is returned, select OK and OK again.

Add the service account user to the computer where the SQL Server Express 
instance is installed and add to Administrator Group
This step can be done by the domain administrator remotely or by any user that is an 
administrator on the computer where SQL Server Express is installed.

Tip: You can use the same service account for other instances of SQL Server Express.

The following procedure is for adding the service account on the computer where SQL Server 
Express is installed

1. From the Start menu, select Control Panel > Administrative Tools.

2. Double-click Computer Management to open the Computer Management MMC console.

3. Expand Local Users and Groups.

4. Right click on Users and select New User.

5. Type the user name and password for the service account you created. These must 
match the service account exactly.

6. Clear the option User must change password at next logon.

7. Select the option Password never expires.

8. Click Create, and then click Close.

9. In the left pane, click Groups
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10. In the right pane, double-click Administrators.

11. In the Administrator Properties dialog box, click Add.

12. In the From this location field, confirm that the location is the local computer, not the 
domain.

13. Type the name of the service account and click Check Names to confirm you have 
selected the correct account.

14. Click OK.

15. If successful, the service account user name displays in the Members list. Click OK.

Set the service account as the Log On account for the SQL Server (SMTKINGDOM) 
service

Note: This step can be done by the SQL Server Express Service Configuration tool installed 
with the instance. The user installing the instance  only need the user name and 
password of the service account.

You must be a local administrator on the computer to set the Log On account.

1. Log in to the network computer where SQL Server Express is installed.

2. From the Start menu, select Control Panel > Administrative Tools.

3. Double-click Services.

4. Right click the SQL Server (SMTKINGDOM) service and select Properties.

5. Click the Log On tab.

6. Select This account and then click Browse.

7. In the Select User dialog box, click Locations. 

8. Expand Entire Directory and select the company domain (network) name. Click OK.

9. Type the name of the service account and click Check Names to confirm you typed the 
correct name.

10. Click OK to return to the Log On tab.

11. Enter and confirm the service account password and click OK.

12. Click Yes in the two messages and OK again in the Log On tab.

13. Restart the service. In the Services list, right click the SQL Server (SMTKINGDOM) 
service and click Restart.

The SQL Server (SMTKINGDOM) service  now be able to access the database files located 
in the Kingdom project folders.

The Kingdom project directories must be shared to the SQL Server (SMTKINGDOM) service 
Log On account (service account).The Log On account must have Full Control permissions to 
the project directories. 
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How do I share my project directories?
You must share your project folder on your computer to the Log On account for the SQL 
Server (SMTKINGDOM) service and give this account Full Control permissions.

1. Contact your network administrator and request the name of the service account that was 
created for the SQL Server (SMTKINGDOM) service.

2. Share your project folder to this service account and give it Full Control permissions.

a. Right click the project folder on your computer and select Properties.

b. Click the Sharing tab and click Share.

c. Type the service account name and click Add. If a matching domain account is found, 
the domain\service account name  appear in the list.

d. Under Permission level, click the down arrow and select Read/Write. Click Share.

Your folder is now shared to the service account. Click Done to exit.

Windows Domain Controller
On Windows Server Systems, a domain controller (DC) is a server that responds to security 
authentication requests (logging in, checking permissions, etc) within the Windows Server 
domain. Windows 2000 and later versions introduced Active Directory.



© 2023 S&P Global. All rights reserved. Reproduction in whole or part without permission is prohibited.

Unable to start the service 

Unable to start the service
There are a number of reasons why the service is unable to start. Microsoft returns 24 
possible reasons. However, the following are the most common:

The user password is not 
valid

Re-enter the password in the Server Configuration dialog box 
and retry.

The user has not been granted 
local “logon as a service” 
rights

If prompted that the user  be added to the local “logon as a 
service” group, click OK.

The domain user is not a 
member of a Group that has 
“logon as a service” rights.

Contact your domain administrator. See Network Project—
Network Database Instance for detailed steps.

The user is not in the 
Administrator group on the 
local machine

Add the service account user to the computer where the SQL 
Server Express instance is installed and add to Administrator 
Group

The user logged in to the 
computer is not a local 
administrator

You must be a member of the Administrator group on the 
computer. Contact your domain administrator for assistance.
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Unable to start the service
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The Administrator Console
This chapter explains how to install the Administrator Console, including the Kingdom 
Enterprise Service and Administrator Console database. If you are using only the 
SeismicDirect Access utility, you only need to install the Administrator Console. You do not 
need to install the Kingdom Enterprise service or the Administrator Console database. These 
components are only required for the Project Access utility.

If you are using the Project Access utility, there is a recommended installation order for all the 
required components. Although you can install the various components of the Administrator 
Console in any order, following the recommended installation sequence will simplify the 
installation process.

If you are installing the components required by the Project Access utility, these installation 
instructions assume you are familiar with the following:

• Microsoft Internet Information Services (IIS) version 6 or greater

• Microsoft SQL Server 2008 R2 or greater

• Creation and configuration of service accounts

• Active Directory users and groups

System Requirements
The following table shows the minimum software and permissions required by the various 
components of the Kingdom Administrator Console.

Installation Sequence
Install the components of the Kingdom Administrator Console in the following order:

1. Administrator Console

2. Administrator Console Database

3. Kingdom Enterprise Service

Component Requirement

Console .NET Framework 4.5

Database SQL Server 2008 R2

Kingdom Enterprise Service • IIS 6.0 or greater
• .NET Framework 4.5

Service Account • Read-only permissions to Active Directory
• Read-only permissions to all Kingdom project directories
• Read/write permissions to the root folder of web site
• Member of Windows Authorization Access group
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If you are using only the SeismicDirect Access utility, you do not need to install the 
Administrator Console database or the Kingdom Enterprise Service. You can always install 
these components later if you choose to use the Project Access utility at a later time.

Related topics
Configuring the Enterprise Project Selector
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Installing the Administrator Console 

Installing the Administrator Console
Whether you are using the Project Access utility, the SeismicDirect Security utility, or both, 
the first component you need to install is the Administrator Console. For the SeismicDirect 
Security utility, this is the only component you need to install. You do not need to install the 
Kingdom Administrator Console on a computer where Kingdom is installed.

The Project Access utility will not work until you install the Kingdom Enterprise Service and 
console database. However, you install the Administrator Console first so it is available to test 
connectivity to the database and proper access to Active Directory with the service account. 

To install the Kingdom Administrator Console:
1. If you are installing from the web, download the Kingdom Administrator Console from the 

Kingdom download site.

If you are installing from the Kingdom USB drive, insert the Kingdom USB drive, click the 
Applications tab in the Installation Manager, and then click Kingdom Administrator 
Console.

2. Follow the instructions in the installer to complete the installation.

Related topics
Installing the Administrator Console Database
Installing the Kingdom Enterprise Service

https://kingdomdownloads.enr.ihsenergy.com/
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Installing the Administrator Console Database
Follow these steps to install the Administrator Console Database. You only need to perform 
the database installation one time. The Administrator Console database requires SQL Server 
2008 R2 or later.

1. Start SQL Server Management Studio.

2. If it is not already connected, connect to the SQL Server database where you want to 
install the Administrator Console database.

3. From the menu, select File > Open > File, and then browse to the \install\SQL folder 
in the Kingdom Administrator Console installation directory (by default, C:\Program 
Files\KINGDOMSuite\KingdomAdminConsole\).

4. Open the install folder and then the SQL folder.

5. Open the EpsDataModel.sql file.

6. Execute the query. This creates the KingdomEnterprise database in SQL Server.

Related topics
The Administrator Console
Installing the Kingdom Enterprise Service
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Installing the Kingdom Enterprise Service
The Administrator Console uses the Kingdom Enterprise Service to browse Active Directory 
for users and groups and to store permissions information in the SQL database. The 
Kingdom Project Selector uses the service to query the database for information about 
access to Kingdom projects based on the credentials of the logged on user where the 
Kingdom Project Selector is running.

Creating the Service Account
The Kingdom Enterprise Service requires a service account that has read-only access to any 
directories where you have Kingdom projects and that also has read-only access to Active 
Directory. This service account also requires read/write access to the root folder of the web 
server where you are installing the service. You can either create a new service account with 
these permissions or use an existing service account that has the needed permissions.

Creating the Application
Follow these steps to create the Kingdom Enterprise Service application on your web server. 
These steps are specific to Internet Information Services (IIS) version 7. There may be slight 
differences in this process if you are using a different version of IIS.

1. Browse to the \install\Web\KingdomEnterpriseService folder in the Kingdom 
Administrator Console installation directory (by default, C:\Program Files 
\KingdomSuite\KingdomAdminConsole\).

2. Copy this folder to the root directory of your web server (for example, 
C:\inetpub\wwwroot\).

3. Start Internet Information Services Manager.

4. In the Connections pane, click Application Pools.

5. In the Actions Pane, click Add Application Pool.

6. In the Name field, type the name of the application pool you want to add (for example, 
KingdomEnterpriseService).

7. In the .NET Framework version list, select .NET version 4.0.

8. Click OK.

9. In the list of application pools, click the application pool you just created (for example, 
KingdomEnterpriseService).

10. In the Actions pane, click Advanced Settings.

11. In the Process Model group, select the Identity property and click [...] to open the 
Application Pool identity dialog box and browse for a service account to use for the 
application pool.

12. On the Application Pool Identity dialog box, select Custom account, and then click Set.
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13. Enter the user name and password of the service account you want the Kingdom 
Enterprise Service to use, and then click OK. 

14. Click OK twice to close the open dialog boxes.

15. In the Connections pane, right-click the KingdomEnterpriseService folder (in the 
Sites\Default Web Site folder) and click Convert to Application.

16. In the Add Application dialog box, click Select.

17. From the list, select the application pool you just created (for example, 
KingdomEnterpriseService), and then click OK twice.

Configuring the Database Location and Credentials
In the KingdomEnterpriseService folder you copied to the root directory of your web 
server, open the Web.config file in a text editor. Update the ConnectionStrings element to 
include the server name, database name, user ID, and password for the Administrator 
Console database you created previously.

Testing the Installation
To test whether the Kingdom Enterprise Service is installed and running, open up a web 
browser and type in the following URL:

http://localhost/KingdomEnterpriseService/ProjectSelector/ProjectDiscoveryService.svc

If you are not testing the service on the web server itself, you will need to provide the name of 
the web server in the URL listed above rather than using localhost.

If the service is running, you will see a page with instructions about how to configure 
metadata publishing. Otherwise check to see that you performed the installation correctly. In 
some cases, you may see a 404.3 error, “The page you are requesting cannot be served 
because of the extension configuration.” Refer Troubleshooting for more information about 
how to resolve this issue.

Related topics
The Administrator Console
Installing the Administrator Console Database
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Configuring the Enterprise Project Selector
As a system administrator, you may want to pre-configure the Enterprise Project Selector for 
your users so they do not have to specify the location of the Kingdom Enterprise Service. To 
do this, you can modify the Kingdom Administrator Console.exe.config file and 
distribute this modified file to each user installation of the Enterprise Project Selector.

To modify the Kingdom Project Selector.exe.config file, follow the steps below:

1. Open a copy of the Kingdom Project Selector.exe.config file in a text editor (this file 
is located in the root Kingdom installation folder (for example, C:\Program 
Files\KingdomSuite\TKS88\).

2. Make the following changes:

Replace

<appSettings>

<add key="ServiceLocation" value="" />

</appSettings>

With

<appSettings>

<add key="ServiceLocation" value="http://companyServerHere/
KingdomEnterpriseService" />

</appSettings>

Where the value is the URL where you installed the Kingdom Enterprise Service.

3. Save your changes in the copied file.

4. Replace users’ copies of the Kingdom Project Selector.exe.config file with the 
modified version of the file.

Related topics
The Administrator Console
Defining Project Access
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Updating the Kingdom Software
Download and apply
For updates for Kingdom versions before 2018 please Contact Us.

Updates for Kingdom versions 2018 and later are available for download from the Kingdom 
Downloads page and the Entitlement Management System (EMS). To access the EMS, you 
need the Entitlement ID (EID) that was included in the Entitlement Certificate sent to the 
primary contact at your company. For more information about accessing the EMS, see the 
Licensing Overview.

To download Kingdom updates from the Kingdom Download page (link is above):
1. Go to the Kingdom Downloads page .

2. Select Kingdom as the product in the left pane.

3. Select the version from the dropdown list.

4. Under Updates, hover over the update you want to install. The Download button will 

activate . 

5. Click the Download button.

6. Wait for the download to complete. This takes a couple of minutes. The file is saved to 
your Downloads folder.

7. To install, when the download is complete, double-click on TKS_version.msp:

8. Follow the installation wizard. That’s it. You are done.

To download and apply the software updates from the EMS:
1. Log on to the EMS using your EID:

https://softwarelicensing.ihsmarkit.com/ems/customerLogin.html.

2. Click Downloads in the upper-right corner.

The Download page contains all of your entitlements. Each license is listed separately, 
but you only need to download the update package once. 

3. Click the Download link beside the update. The download file is 
TKS_[version]_[update].msp.

4. Double-click the update file (*.msp) to start the Update Wizard and then follow the wizard 
to complete the installation.

Note: If you are updating a version of Kingdom 8.8 or earlier, the update package is a 
zip file. Update instructions are included.

https://kingdomdownloads.enr.ihsenergy.com/
https://kingdomdownloads.enr.ihsenergy.com/
https://softwarelicensing.ihsmarkit.com/ems/customerLogin.html
https://ihsmarkit.com/about/contact-us.html
https://softwarelicensing.ihsmarkit.com/ems/customerLogin.html
https://kingdomdownloads.enr.ihsenergy.com/
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